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Where to Find Help When You Need It 
 
Help from your Division/College’s Computer Consultant 
Some divisions and colleges have computer consultants assigned to them.  You can contact these consultants when you need 
help.  To determine if you have a consultant assigned to your division or college, look to: 
http://rohan.sdsu.edu/~facstaff 
 
Help from the BATS Web Page  
BATS (Baseline Access, Training and Support) is a California State University initiative to provide all students, faculty, and 
staff with "baseline" access to information resources via networks, training in the uses of baseline hardware and software 
systems, and ongoing professional and technical support for utilization of computer resources at San Diego State University.  
You can access the BATS Web Page by pointing your browser to: http://rohan.sdsu.edu/~bats/ 
 
Help in the San Diego State University, Faculty Room 
The Faculty Room is staffed Monday through Friday with computing consultants who will try to answer your questions.   
Location:    Adams Humanities, 1109 
Phone Number:   x45727 
Semester Hours:   7:30am – 6:00pm Monday -Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 

 
Help from the Faculty Computing Help Line 
Phone Number: x41348  E-mail: helpline@mail.sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 
 
Help from the Staff Computing Help Line 
Phone Number: x40824  E-mail: staffhelp@sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 
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CUSTOMIZING 
THE 
BACKGROUND 

When you create a presentation, you can choose from a variety of 
Design Templates residing in PowerPoint.  Design Templates allow you 
to give your presentation a special appearance.  Generally you want to 
select a Design Template that complements the information contained in 
the presentation. 
 

Create New Design 
Template 

If you don’t want to use any of the canned Design Templates, you can 
create your own custom template. 
 
To create your own template: 
 
1. Open a new PowerPoint presentation. 
 
2. If you want to modify an existing template select the desired 

template. 
 
3. Make any changes you desire to the template.  You can change the 

master title or text style to a different font, you can change the 
background color, bullet styles or you can a logo, a picture or a 
Word Art image to the template. 

 
4. When finished, click on File on the Menu Bar and choose Save As. 
 
5. In the drop down list, choose Design Template.  The templates 

folder will automatically display. 
 
6. Name the new template and click on the Save button. 
 
 

OUTLINE MODE You can use the PowerPoint outline tab to create and/or organize the 
information in your presentation.  The outline tab appears on the left 
side of the PowerPoint window. 
 
To view the Outline Tab, click the Normal View button in the lower-
left corner of the window.  The Outline tab will be selected. 
 
Each slide in the presentation will be numbered and you will be able to 
see up to five levels of detail for each slide. 
 
To enter new content into your presentation, simply type the 
information and press the <Enter> key. 
 
Outlining Toolbar 
 
An Outlining Toolbar is available to help you organize and arrange your 
slides.  To see the toolbar, click on View on the Menu Bar, choose 
Toolbars and then choose Outlining Toolbar. 
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The buttons on the toolbar function as follows: 
 

 
Promote 

Applies the formatting and style of the level 
that is one step above the level of the 
selected text. 
 

 
Demote 

Applies the formatting and style of the level 
that is one step below the level of the 
selected text.  Demoting a slide title moves 
the text of the selected slide to the previous 
slide. 
 

 
Move Up 

Moves the selected text ahead of the 
previous item in the outline. 
 

 
Move Down 

Moves the selected text beneath of the 
previous item in the outline. 
 

 
Collapse 

Hides all the body text for the selected 
slides 
 

 
Expand 

Displays all the body text for the selected 
slides 
 

 
Collapse All 

Hides all the body text in the outline 
 
 

 
Expand All 

Displays all the body text in the outline 
 
 

 
Summary 

Slide 

Creates a new slide that lists all the titles of 
the slides in the presentation 
 

 
Show 

Formatting 

Shows the actual presentation font 
formatting on the outline tab 
 

 
If you promote a first level subheading, a new slide will be created and 
the text will become the title text for the new slide. 
 
 

Creating a Presentation You can create the text of your presentation in Outline View. 
 
When you open a new presentation click on the Index tab to the left of 
the screen.  You will see a single slide represented.  Click to the right of 
the slide and enter the title text for the first slide. 
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Press <Enter> and a second slide will be created.  If you want to add 
additional text to the first slide, press the tab key after you press the 
<Enter> key and you will be able to add text to the first slide. 
 

Editing You can edit the text in your presentation in Outline View.  To move a 
line of text, click on the Move Up or Move Down button on the 
Outlining toolbar.  The text will move up or down in order in the slide, 
and if you continue clicking the button, the text will move to the next or 
previous slide. 
 
If you decide that a line of text needs to become a new slide, click on 
the Promote button.  If you want a slide title to become a subtitle in the 
previous slide, click on the Demote button. 
 
 

SLIDE MASTER 
 

 
 
 
 

Title Master 
 
 
 
 
 
 
 

 

The Slide Master exists to give you a uniform look to all your slides.  
You can modify the Slide Master in a variety of ways. 
 
You can change the default fonts, placeholders, background design, 
color scheme and bullets, or you can add a logo to the master. 
 
To modify the Slide Master: 
 
1. Click on View on the Menu Bar, choose Master, and then choose 

Slide Master. 
 
2. Select the area you wish to modify and then apply the formatting or 

other changes you desire. 
 
If you are going to use your title page multiple times in your document 
and you want the page to have a consistent look throughout your 
presentation, you can modify the Title Master. 
 
You will have to create a new Title Master while in the Slide Master 
view.  To create a new Title Master while in Slide Master view: 
 
1. Click on the Insert New Title Master button on the Slide Master 

View toolbar.  A new Title Master will be created. 
 
2. Make your changes to the new Title Master. 
 
3. When finished click the Close Master View button on the Slide 

Master View toolbar. 
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ANIMATION Animation can have several purposes, but one of the most important 
purposes is to help the viewer focus on the point being made. 
 
The following steps will take you through the creation of an Oval and 
attaching the animation to make it direct the viewer’s attention to the 
point being made. 
 
1. From the Drawing Toolbar, click on the Oval tool and draw an Oval 

on the slide. 
 
2. Double click the Oval to see the Format AutoShape window. 
 
3. In the Fill section of the window, set the Transparency to 100% 
 
4. In the Line section of the window, choose a color for the Oval.  

Change the weight to 3 points. 
 
5. Click on OK to close the window. 
 
6. Drag the shape over the text you want attention drawn to. 
 
7. With the Oval selected, click on Slide Show from the Menu Bar and 

choose Custom Automation. 
 
8. Working in the Task Pane to the right of your screen, click on Add 

Effect and choose the desired effect. 
 
9. In the Start window, choose how you want the animation to start. 
 
10. Choose the Direction and Speed desired. 
 
11. Click on the Play button to see the animation. 
 
 

DRAWING 
TOOLBAR 

The Drawing Toolbar contains a powerful set of drawing tools that are 
available for use in PowerPoint. 
 
If you learn to use the tools in PowerPoint, you will be able to use them 
in the Microsoft Word and Excel applications, even though there are 
some minor differences. 
 

Viewing the Drawing 
Toolbar 

By default, when you open PowerPoint, the Drawing Toolbar appears at 
the bottom of the screen. 
 
If the Drawing Toolbar does not automatically appear at the bottom of 
the screen, it can be displayed by selecting View from the Menu Bar 
and then selecting Toolbars and then Drawing. 
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Selecting Objects 
 

 
 

Since many drawings contain multiple objects, you may need to select 
these multiple objects at the same time. 
 
To select multiple objects, click on the Select Objects button and drag 
the pointer across all the objects you want to select.  Only objects that 
are entirely within the selection area will be selected. 
 
Another way to select objects with this tool is to click on one object, 
hold down the Shift key and select additional objects. 
 

Draw Menu 

 
 
 
 
 
 
 

This menu offers a variety of drawing related tools: 
 
Group 
 
If you have multiple objects in the document, you can select them all 
and then choose Group.  This allows you to work with them as a single 
object. 
 
Ungroup 
 
If you have grouped objects and you want to work with them 
individually, select Ungroup. 
 
Regroup 
 
To regroup objects that were previously grouped; select one object in 
the group and choose Regroup.  If you do not select an object prior to 
choosing Regroup, the last group of items that you previously 
“ungrouped” will be “regrouped” by default. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Order 
 
When you bring objects into your document, these objects are 
automatically “ordered” or “stacked” individually on top of each other 
as you insert them. 
 
You have six options to choose from when stacking objects.  To change 
the order in which objects are stacked: 
 
1. Select an object. 
 
2. From the Draw Menu choose Order and then select one of the 

following options: 
 

• Bring to Front - Brings the selected object to the very front (on 
top of all other objects). 

• Send to Back - Brings the selected object to the very back 
(behind all objects) 
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• Bring Forward - Brings the selected object one step closer to the 
front 

• Send Backwards - Brings the selected object one step toward the 
back 

• Bring in Front of Text - Positions the object on top of text that is 
in the document. 

• Send Behind Text - Positions the object so that text is displayed 
over the object. 

 
Grid 
 
An invisible matrix covers the entire page and it is used to align objects 
automatically. As you drag or draw an object it’s pulled into alignment 
with the nearest intersection of gridlines. 
 
Snap to Grid 
 
If Snap to Grid is checked, when you move or nudge an object its 
corners align to the nearest intersection of the grid. Horizontal and 
vertical settings can be changed, as well as horizontal and vertical 
origins. 
 
Snap Object to Other Objects 
 
This option aligns objects with other AutoShapes. 
 
Nudge 
 
Use this selection to move objects in small increments.  You can move 
the object up, down, right or left. The arrow keys on the keyboard 
perform the same function. 
 
Align or Distribute 
 
Objects can be aligned with other drawing objects or they can be 
aligned in relation to the entire page. 
 
To align objects:  
 
1. Select an object. 
 
2. From the Draw Menu choose Align or Distribute and then select one 

of the following options: 
 

• Align left, right, top, bottom - This aligns objects by their 
edges. 
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• Align center, middle: This aligns objects horizontally (by their 
centers) or vertically (by their middles). 

• Distribute horizontally, vertically: This arranges objects equal 
distances from each other. 

• Relative to page: When this option is selected, his arranges 
the selected objects across the width of the page or the height 
of the page.  

 
Rotate or Flip 
 
NOTE: Some objects (text boxes, bitmaps and some graphics) cannot 

be rotated or flipped. 
 
Free Rotate (also a button on the Drawing Toolbar): 
 
When you select an object and then choose this option, green handles 
appear at corners of selected object and the cursor turns into rotate 
symbol. 
 
Place the cursor over a green handle, then drag a corner in the desired 
direction 
 
Click outside the object to set the rotation. 
 
Text Wrapping 
 
This tool enables you to dictate how a graphic interacts with text.  There 
are a variety of options to choose from: 
 

• Square - wraps text around all sides of the selected object.  Some 
room remains between the object and the text. 

• Tight - wraps text tightly around the edges of the actual image.  
Very little room remains between the object and the text. 

• Behind Text - allows the text to flow over the image. 
• In Front of Text - allows the text to flow behind or under the 

image. 
• Top and Bottom - wraps text around the top and bottom of the 

selected object.  Text stops above the object, and resumes below 
the object. 

• Through - same as tight, but without a fixed outer wrapping 
boundary.  This option allows text to fill gaps in the image. 

• Edit Wrap Points - This option enables you to control precisely 
where text wraps to refine your page layout - for example, to 
accommodate a long word that would otherwise wrap oddly. 
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Reroute Connectors 
 
Allows you to reroute a “connector” that is connected to two objects so 
that the connection is made through the shortest distance. 
 
Edit Points 
 
This option allows you to edit the wrap points around an object. 
 
Change AutoShape 
 
This option allows you to change the selected object into any other 
shape, and it will maintain its size, colors and position. 
 
Set AutoShape Defaults 
 
If you draw an object and then add customized colors and line styles, 
you can set these options as the default.  Then every time you create an 
AutoShape it will display with your customized colors and line styles. 
 

Drawing Lines  
 

 
 

Using the Drawing Toolbar you can draw lines, assign colors to the lines 
and assign styles to the lines 
 
Line Tool 
 
To draw a line: 
 
1. Activate the tool by clicking on the Line Tool. 
 
2. Click in your document where you want the line and then draw the 

line. 
 
3. When done, release the mouse button. 
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 Line Color  
 
To change the color of a line: 
 
1. Select the line. 
 
2. Click on the small black arrow to the right of the Line Color 

button. 
 
3. From the pallet of colors presented, select the desired color. 
 
 
 
 
 
 
 
 
 
 
 
More Line Colors 
 
If the desired color is not in the pallet of colors, click on the More Line 
Colors button. 
 
You can choose additional colors from either the Standard or Custom 
tabs. 
 
You can even make the object color semi-transparent by checking the 
Semitransparent box. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Patterned Lines 
 
The Patterned Lines option enables you to choose from 48 different 
patterns, and you can customize the look by choosing different 
foreground colors and background colors. 
 
Line Styles 
 
By using the Line Styles tool, you can change the thickness and style of 
the line you’ve drawn. 
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 More Lines 
 
This option in the Line Styles menu takes you to the Format AutoShape 
window.  Here you have the option of choosing unique beginning and 
ending styles. 
 
Dash Style 
 
This tool allows you to change your solid line into a variety of dash 
styles. 
 

Drawing Arrows 
 
 
 
 
 
 
 
  

The Arrow button on the Drawing Toolbar provides you the option of 
adding a variety of arrows to your document. 
 
Once you’ve drawn your arrow, you can use all of the features listed 
above for LINES.  You can change the color of the arrow and assign 
styles and custom widths to the arrow. 
 
Arrow Styles 
 
A separate button on the toolbar gives you the option of selecting a 
variety of arrow styles.  Simply select the arrow, click on the Arrow 
Style button and choose the style of arrow you desire. 
 
More Arrows 
 
This option in the Arrow Styles menu takes you to the Format 
AutoShape window.  Here you have the option of choosing unique 
beginning and ending arrow styles. 
 

 
 
 

Dash Style 
 
This tool allows you to change your solid arrow into a variety of dash 
styles. 
 

 

COMBINING 
PRESENTATIONS 

You have the option of taking slides from “Presentation A” and 
combining them with the slides in “Presentation B”. 
 
To insert slides from another presentation: 
 
1. Choose Insert from the Menu Bar, then select Slides from Files to 

open the Slide Finder dialog box. 
 
2. From the Find Presentation tab, click the Browse button to open the 

Browse dialog box.   
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3. Find the file you would like insert slides from.   
 
4. Click on Open to display presentation in the lower portion of the 

dialog box.   
 
5. Select the slide (or slides) you want to insert and click Insert.  If 

you want to insert all the slides select Insert All. 
 
6. If you check the Keep Source Formatting box, the inserted slides 

will keep the formatting applied to them in the old presentation.  If 
you leave this check box blank, the inserted slides will take on the 
formatting applicable to your new presentation. 

 
7. Click the Close button to exit the dialog box. 
 

 

HEADER/FOOTER 
 

 

 

You can include text, slide or page numbers and dates at the top or 
bottom of your slides or notes and handouts. 
 
Headers and footers can apply to all slides or selected slides.  When a 
header or footer is applied to notes and handouts they are applied to all 
notes and handouts. 
 
To apply a header or footer: 
 
1. Click on View on the Menu Bar and then choose Header and 

Footer… 
 
2. To put a header/footer on Slides, select the Slide tab.  To put a 

header/footer on Notes and Handouts select the Notes and 
Handouts tab. 

 
NOTE:  By default, Notes and Handouts include page numbers, but 
you can turn these off.  

 
3. If you want to change the font style for headers and footers or the 

position, size, and formatting of the placeholders that contain 
headers and footers, make the changes on the slide master, notes 
master, or handout master. 
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REPLACE FONTS 
 

If you decide to change a font in your presentation, you can make the 
change on all the slides at one time. 
 
To change a font: 
 
1. Click on Format on the Menu Bar and then click on Replace 

Fonts… 
 
2. In the “Replace” window you will see a drop down list of all the 

fonts used in the presentation.  Select the font you want to replace. 
 
3. In the “With” window select the font you want to use. 
 
4. Click on Replace and the change will be made on all the slides in 

your presentation. 
 

 

PACKAGE FOR CD 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

The Package For CD option allows you to save your presentation in a 
way that it can be used on another computer even if that computer 
doesn’t have PowerPoint and even if that computer doesn’t have the 
fonts you used in the presentation. 
 
You can also package one or more presentations into a folder on your 
computer or at a network location instead of onto a CD. To do this, click 
on Copy to Folder and then navigate to the folder on your computer or 
on the network. 
 
To copy the presentation to a CD: 
1. Insert a CD into the CD drive.  

2. From the File menu, click on Package for CD.  

3. Name the CD if desired. 

4. To include additional presentations of files, click Add Files.  
Choose all the files you want to include on the CD and then click 
Add. 

5. Click Options to change the following default settings: 

• To not include the PowerPoint Viewer, uncheck the 
PowerPoint Viewer check box.  

• To choose how the presentations will play in the viewer list, 

click on the   and choose from the following options: 
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• To include linked files check the Linked Files box. 

• To include TrueType fonts, check the Embedded TrueType 
fonts box.  

• To asign a password to open or edit the presentation, type the 
password that you want to use. 

• When finished, click OK.  

6. To copy the file(s) to a CD, click Copy to CD. 
 

 

PRESENTATION 
TIPS 
 
 

 

1. Pressing the “B” key while the presentation is running will cause the 
screen to go black. A mouse click or a keystroke will start the 
presentation running again. 

 
2. Pressing the “W” key while the presentation is running will cause 

the screen to go white. A mouse click or a keystroke will start the 
presentation running again. 

 
3. Click once with the right mouse button and a menu will appear 

giving you the option to move forward or backward in the 
presentation, go to a specific slide or end the presentation 

 
4. To quickly go to a specific slide while presenting, enter the slide 

number and press the <Enter> key. 
 
5. Choose a background that lends itself to the presentation topic.  For 

instance use a map for geography or history lesson. 
 
6. Choose a background that will not distract your audience from your 

presentation. 
 
7. Limit the use of the slide transition feature to one or two different 

transitions. 
 
8. Pressing Ctrl + P while presenting will activate the pen tool. 
 
9. Pressing the E key while presenting will erase all on screen 

annotations. 
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10. Keep the use of animation to a minimum to prevent distracting the 
audience. 

 
 


